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Abstract

This document describes the usage of the graphical user interface (GUI) of the data
mining software packageYale . Since the interface was intended to ease the usage ofYale
avoiding handling of XML con�guration �les, there should be almost nothing to explain.
Hence this document describes the very basic ideas ofYale and their representations
in the GUI. We suggest that you �rst make the online tutorial a nd read this document.
After that, you will �nd it much easier to read the Yale Tutorial and skip a lot of its
contents.

Contents

1 General Information 1

2 Setting up an experiment 2
2.1 The online tutorial . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
2.2 The Wizard . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
2.3 The tree view and other experiment views. . . . . . . . . . . . . . . . . . 4

2.3.1 Editing parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . 4
2.4 Creating, deleting, moving and replacing operators. . . . . . . . . . . . . 5
2.5 Operator info . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
2.6 The attribute editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

3 Validating your experiment 8

4 Running your experiment 9

5 Evaluating the results 10
5.1 Plotter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

5.1.1 Zooming. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12

6 Settings 12

1 General Information

Although the Yale tutorial and this GUI manual contain a huge amount of information
about Yale and all of its parts, it is often very convenient to get the desired information
during work. Therefore, we added an online help function to almost all parts of Yale .
Each parameter, operator and GUI item displays information as tool tip text which ap-
pears after holding the mouse cursor a few moments above the object at hand.
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2 Setting up an experiment

When Yale starts up it presents you a welcome screen that lets you choose between �ve
possibilities

� Create a new, empty experiment

� Use the Wizard

� Open one of the recent experiments

� Open an existing experiment

� Start the online tutorial

2.1 The online tutorial

When you start Yale the �rst time you should probably make the online tutorial. I t
explains the main concepts, the GUI usage and shows many of the operators provided by
Yale .

2.2 The Wizard

We assume that you have chosen to start the Wizard (�gure 1). The Wizard is also
available from the File menu. The Wizard guides you during the process of creating a
new experiment. You start by selecting a template experiment from a list. This template
serves as a kind of skeleton for your experiment.

Figure 1: The Yale experiment Wizard is a simple way to create basic experiments.

Experiments in Yale are made up from a set of nested operators. An operator con-
sumes a set of input objects and produces some output objects. These objects can be
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data �les, models, performance criteria, and more. Simple operators like a learner con-
sumes an example set and produces a model that can be used by anapplier for prediction.
Moreover, some operators can have inner operators.For Example, a k-fold cross-validation
splits up an example set into training set and test set and applies its inner operators which
are a learner and an applier. Each time a disjoint test set is used.

If you click on the radio button next to the cross validation t emplate, the structure
of the sample experiment is depicted on the right. You see an operator chain consisting
of an ExampleSourcethat reads data from a �le. This data is then passed to the cross-
validation which itself has inner operators, in this case learner and applier for a support
vector machine (SVM). See theYale Tutorial for more information on SVMs and the
individual operators.

Now that you have chosen the template, click onnext. In this step you can enter some
of the most important parameters (�gure 2). In case of a cross-validation this is e. g. the
number of validations.

Figure 2: The parameter editing step of the Wizard.

A lot of Experiments in Yale need a data �le as input which is known in supervised
learning as an exampleset. The example sets have to be in a special format and requires
that the attributes are described in a seperate XML �le. In ot her words the �le in special
format is the set of examples where each example is a vector and the XML �le describes
the semantics of every value in the vector.

In order to create such an XML �le now you can press the smallEdit button next to
an attribute description �le property. The dialog popping u p is described in section2.6
and is called Attribute Editor. The �les generated with help of the Attribute Editor can
also be used as input for the ExampleSource operator, which is the standard data input
operator for Yale .

An even more convenient way of loading almost arbitrary data�les into Yale and to
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de�ne attribute description �les for your data is to use the E xample Source con�guration
wizard. Just press theStart Con�guration Wizard. . . button at the top of the parameter
table of the operator. Con�guration wizards are also available for other operators which
are hard to de�ne, e.g. for the DatabaseExampleSource operator.

2.3 The tree view and other experiment views

As operators can have inner operators and each operator except the root operator is
enclosed within another operator the natural representation of an experiment is a tree.
If you have used the Wizard, you see your experiment on the left side. If you did not
use the Wizard you see an empty experiment consisting only ofan empty operator chain.
Figure 3 shows this main experiment view which is called \tree view".

Figure 3: Main tree view of the experiment editor window.

By clicking on the XML tab you see the XML con�guration �le that describes your
experiment (�gure 4). If you like you can always edit it by hand using your favorit e text
editor. For more information about the XML con�guration �le s see theYale Tutorial.
Selecting the Box tab shows a nicer box representation of your experiment you already
know from the Wizard. You can use this view for printing. Clicking on Tree brings you
back to the tree view.

2.3.1 Editing parameters

To the right of the tree you see a table with two columns labeled \Key" and \Value".
Depending on the selected operator you can enter the parameters of this operator. Manda-
tory parameters are set in bold face. Some of the parameters may have a default value
which will be used if the cell is no other value was speci�ed. If the value you entered is
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Figure 4: The Yale XML con�guration editor

out of range it will be corrected automatically. Some parameters accept only numbers,
others let you select from a list of values. For �le parameters the �le name can be entered
into the text �eld or the �le selected by means of a �le chooser dialog, that pops up when
pressing the[...] button. All �le names can be de�ned relatively against the lo cation of
the experiment �le. Of course this only works after the experiment was saved.

Tip: keep the mouse cursor a few moments above a parameter. Usefulinformation
about the parameter will be displayed as tool tip text.

2.4 Creating, deleting, moving and replacing operators

If you started with a blank experiment or you want to modify an experiment created by
the Wizard, the thing you probably want to do is create a new operator.

Since this feature seemed most important to us it is accessible from many places:
from the Edit menu, the icon bar below the menu bar, the icon bar below the tree, the
context menu popping up whenever you right-click on an operator of the tree, or simply
by pressing[Ctrl-I] . Figure 5 shows the icon for operator adding.

Figure 5: The new operator icon.

Whichever way you choose to activate this function, it will pop up an operator browser
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that lets you choose the operator type (select a group or input or output types �rst if you
want to decrease the number of possible selections). This browser displays all available
information about the currently selected operator. You should name the operator before
you add it into your experiment. You can always rename an operator by pressing [F2]
or triple clicking it in the tree view. Figure 6 shows the operator browser.

Figure 6: The Operator Browser for information and operator adding.

Another way to add an operator is to right click on the parent operator and select
the operator from the New operatorsubmenu. Adding operators directly from the context
menu is a very fast way of experiment design. Both ways of adding are only possible if
an operator chain is selected, i.e. an operator which can have children.

Tip: keep the mouse cursor a few moments above an operator in the submenus. Useful
information about the operator will be appear as tool tip text.

You can replace an operator by selecting the new operator from the submenuReplace
operatorof the context menu. This is similar to adding a new operator from the context
menu instead of using the operator browser. When you replacean operator chain the
inner operators will remain. Therefore, operator chains containing any children can only
be replaced by other operator chains.

Removing the operator is even easier. Just press[Delete] or select the corresponding
menu item from the context menu or the Edit menu. Figure 7 shows the icon for operator
deleting.
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Figure 7: The remove operator icon.

You can use the arrows below the tree to move an operator up or down within its
enclosing operator chain or wrapper. If you want to move an operator from one chain to
another, you may cut and paste it.

2.5 Operator info

Pressing [F1] brings up a dialog with useful information about the currently selected
operator. This option is also available from the context menu of each operator or the
Tools menu. This operator info dialog displays:

� a short description

� which input the operator demands

� which output the operator delivers

� the minimum number of inner operators, if the selected operator can have children

� the maximum number of inner operators, if the selected operator can have children

� errors in experiment setup (if errors exist)

� a description or comment text �eld

You can specify HTML comments to this operator in this dialog which are saved in the
XML �les. If you specify a comment for the root operator of the experiment, this comment
is displayed in a dialog each time the experiment was loaded.

2.6 The attribute editor

Example sets or instance sets inYale are described using a separate XML document.
This attribute description �le contains information about the type of data and its source.
Data sets can be distributed over several �les. This may be particularly useful if the label
is stored within a �le of its own. The Yale Tutorial will give help in case you want to
edit this �le yourself.

The GUI displays a small Edit button next to a attribute description �le property
(e. g. the parameter attributes of an ExampleSource) in the property editor. A dialog
called Attribute Editor will pop up containing a table with o ne column for each attribute
(�gure 8). If the property does not yet reference a proper attribute description �le, the
dialog will be empty. If you want to follow the instructions b elow which describe how to
create the XML description �le, you can click on clear, which is in the menue bar under
table to start from scratch.

Assume, you have a data �le containing 50 rows of whitespace or comma separated
attribute values, �ve each row. Click on load data to open that �le. After that you should
see �ve columns with some headers each and the data in the table cells. Question marks
(\?") indicate missing values. The following enumeration explains the meanings of the
table headers:

1. The �rst header contains the source �le and column index. This is not editable but
just for your information.

2. The second row indicates, what the data is used for. It can either be an ordinary
attribute, a label for classi�cation or regression tasks, or a weight that can be used
with certain algorithms. There can be at most one label and one weight attribute.
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Figure 8: The Attribute Editor dialog for data loading and at tribute description �le creation.

3. The third row is the SI unit given as a sequence of of basic unit and exponent. An
example: The unit Newton would be speci�ed askg1m1s-2, because 1N = kg �m

s2 . An
exponent of 1 can be omitted. This feature is useful if you want additional features
to be generated automatically, e. g. by aFeatureGenerationOperatoroperator. Units
are taken into account to restrict useless attribute combinations, e. g. adding a time
and a distance attribute.

4. The fourth row is the value type. Most interesting are the choicesreal / integerand
nominal. Yale should have automatically detected these correctly.

5. The last header row is the block type. Most interesting aresinglevalue (default)
and valueseries. For some experiments value series are treated in a special way. Do
not forget to assignvalueseriesstart and valueseriesendto the �rst and last column
respectively.

You can change the values according to your needs and load an arbitrary number of data
�les. Finally click on Save attribute description �le, which you can �nd in the �le menue,
to write the XML �le to disk.

Tip: If you do not want to use this Yale standard data format, you can use one of the
provided special format operators which can read Ar� �les, comma separated value �les
(csv), bibtex �les, dBase �les, C4.5 �les, and more.

Tip: An even more convenient way of loading almost arbitrary data�les into Yale and
to de�ne attribute description �les for your data is to use th e Example Source con�guration
wizard. Just press theStart Con�guration Wizard. . . button at the top of the parameter
table of the operator. Con�guration wizards are also available for other operators which
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are hard to de�ne, e.g. for the DatabaseExampleSource operator. The wizards are self
explaining, just follow the steps and read the instructions.

3 Validating your experiment

Before you run your experiment you should validate it. You can click on Validate experi-
ment in order to check if all operators are nested correctly, provided with their necessary
input and mandatory properties are set (�gure 9). Although this might be useful, you
do not need to do it manually, since these checks are performed automatically before an
experiment is started.

Figure 9: The validate experiment icon.

The result of the validation including all error messages isprinted into the message
viewer at the bottom of the main frame. Additionally they are indicated by an exclamation
mark next to the operator in the tree view. An example is shownin �gure 10. You can
display these messages and more information about the operator by pressing [F1] or
selecting theOperator infomenu item from the context menu or from the Tools menu.

Figure 10: Error Messages in the Message Viewer (lower part)highlighting the errors in the
experiment.
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Experiment validation is very important in order to create p roper experiments and
can help to understand the concepts of Yale. We therefore recommend to use experiment
validation as often as possible, at least once before you start your experiment. Together
with the breakpoints from the operator context menu it is usually much easier to design
new or complex experiments.

4 Running your experiment

Running your experiment is quite easy. SelectRun from the Experimentmenu or click the
corresponding play button which is shown in �gure 11.

Figure 11: The experiment run icon.

You may follow the progress of your experiment by observing the output which is
displayed in the Message Viewer. Note, that in GUI mode, the output does not need to
be written to a log �le. If you did not specify a log �le you can a lways save the message
viewer contents to a �le by selecting the corresponding menuitem in the Message Viewer's
context menu. You can also perform a search in the Message Viewer. This option is also
accessible from the context menu of the viewer.

Tip: The amount of logging messages can be de�ned by the parameterlog verbosityof
the experiment operator (the root of the experiment tree). This operator also provides
other parameters useful for the complete experiment.

5 Evaluating the results

When your experiment is �nished, you will be presented with the results, i. e. all output
returned by the outermost operator. This can be performancestatistics, a decision tree
or anything else. Yale automatically selects the Resultstab.

When your experiment was conducted successfully, the view automatically switches to
the Resultstab. As far as your experiment chain produces an output, thistab shows you
a visualization or a text describing the output. Figure 12 shows a decision tree learned
from the golf data set.

At any time you can stop or pause (and resume) the experiment using the appropriate
buttons or menu items in the Experimentmenu. In any case the operator currently being
executed will �nish its execution. Since this might take some time (e.g. if the current
operator was a learner) this might lead to a delay for experiment termination. Please be
patient.

If you want to observe your experiment closely, you can set breakpoints before and
after every operator (via the operator context menu). In that case, each time a breakpoint
is reached, intermediate results are presented similar to the dialog popping up at the end
of the experiment. You have to change to theResultstab to view the intermediate results.
While your experiment is running you can observe the progress on the Monitor tab. You
can see a plot of the memory usage and the progress bar.
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Figure 12: A decision tree as result of an experiment.

5.1 Plotter

In case you used theExperimentLogOperator, you also �nd the produced plots as shown
in �gure 13. The results can be viewed online during the run of an experiment. On the
left hand side you can select the value that is assigned to thex-axis and one or more of
the values that should be plotted on the y-axis. The example shows a plot of the squared
error depending on the SVM parameterC.

Additionally, the standard scatter plotter can use three dimensions. There are two
3D plot modes integrated in Yale . The �rst one (3D (color) scatter plot) produces 3D
plots, which can be rotated by dragging the mouse over the plot. The second 3D plot
mode of Yale is the 2D color plot mode. The �rst two dimensions build an 2D layer and
the third dimension is mapped on di�erent colors. Other plot ters exist for scatter plots
or histograms. Table 1 gives an overview over all existing plotters.

There exist several objects which can also be plotted, e.g. Example sets have a meta
data view, a data view, and a plot view. In plot view some features can be selected to
build the dimensions of a plot. Figure 14 gives an example for the plot view of the well
known Iris dataset.
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Plotter Description
Scatter A 2D scatter plot which is also capable of plotting lines

and a third dimension by colorizing the third dimension
Scatter Matrix A matrix plot of scatter plotters
Scatter 3D A 3D scatter plot
Scatter 3D Color A 3D scatter plot colorizing a 4th dimension
Parallel A plotter where each dimension is plotted on parallel

coordinates
Survey A survey plot plotting sorted histograms on parallel

coordinates
SOM A Self-Organizing Map plot using a Kohonen net for

dimensionality reduction
Density A 2D plotter using two dimensions as axis, one dimension

as density color, and one dimension for point colors
Andrews Curves A parallel coordinates plot after a sort of Fourier

transform
Histrogram A histogram plot for one of the dimensions
Histrogram Color A histogram plot for one of the dimensions where the

values are binned according to another (nominal)
dimension beforehand

Histrogram Matrix A histogram plot for all dimensions
Histrogram Color Matrix A color histogram plot for all dimensions binned

by one (nominal) dimension beforehand
Quartile A quartile plot (aka box plot) for one of the dimensions
Quartile Color A quartile plot for one of the dimensions where the

values are binned according to another (nominal)
dimension beforehand

Quartile Color Matrix A color quartile plot for all dimensions binned
by one (nominal) dimension beforehand

Bars 2D A 2D bars plot, i.e. a 2D scatter plot where all points
are connected to the x-axis

Bars 3D A 3D bars plot, i.e. a 3D scatter plot where all points
are connected to the x-y-plane

Box 2D A 2D scatter plot where another dimension can de�ne a
box around the points (often used for variance)

Box 3D A 3D scatter plot where another dimension can de�ne a
box around the points (often used for variance)

RadViz A plotter with radial visualisation anchors
GridViz A plotter with grid visualisation anchors
Surface 3D A 3D surface plot (only available for less data points)
Hinton A Hinton plot for one of the dimensions
Bound A Bound plot for one of the dimensions

Table 1: The most important Yale plotters.
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5.1.1 Zooming

Drag a rectangle to zoom into the selected range. Right clicksets the view back to
maximal range. This type of zooming is only supported for the2D scatter plots. For
some of the other plotters zooming might be implemented during a slider in the options
pane on the left or even by simply turning the mouse wheel.

Figure 13: A plot of a parameter optimization run.

6 Settings

You can open a dialog for global settings from theFile menu. These settings specify
the behavior of Yale for di�erent tasks, e.g. if the system should beep at the end of
experiment or how many examples are displayed in the result viewer pane. The settings
dialog allows to set all global properties described in theYale tutorial, including the path
to the executables of external programs. You can apply the changed settings only for the
current session or save them for future sessions.
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Figure 14: A plot of the well known Iris example set
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